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What is i-Tree?

“Putting US Forest Service science into the hands of users.”

Benefits-based approach

* Based on peer-reviewed research

A 15-year collaborative effort Dyt

e Technical Support

i-Tree Users
Warldwide: 320,000+

* www.itreetools.org e

United States
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Why i-Tree?

Opportunities for communities to...

Y

* Plan and manage urban forest resources more
strategically to serve and protect citizens;

* Integrate urban forests in policies: sustainability,
climate, resiliency, air quality, public health,
stormwater, etc.;

e Support advocacy efforts with data;

* Improve preservation of trees and forests;

e Connect urban and rural forest importance.




Why i-Tree?

Opportunities for communities to...

I Project
Learning
Tree'

TEACHING WITH

Economic opportunities:
attract & retain new businesses and residents;

Promote green tourism and investment;

Create green industry jobs;

Sustainable development; |
Myef Estimates of Your Tree Benefits

Proves Soldutionss fr  Gronniog, Workd Maore than an investment in beouty and shade, your trees work hard for you!

Youth education & engagement; |

Prepared exdusively for: John Deere HQ -t v

Estimated Tree Cover for your property: 43.7%

Develop new relationships & partnerships... oo

each year by yourtrees:
13,004,647 gallons @ $115,741

Carbon Dioxide absorbed
each year byyourtrees:

2,876tons @ $101,412

Carbon Dioxide already
stored in/your trees:
78.163tons @ $2.755.674



i-Tree’s Vision L S

| Save on Your
| Energy Bills by
g\ | Planting Trees
To improve forest and human | 4 e

health, and forest and city resiliency

through easy-to-use technology |
that engages people globally in Help Us Breathe Easier
. Think about it...

enhancing forest management.




Quantify Tree Benefits  with Science!

Carbon dioxide storage and sequestration
Air pollution removal
Storm water reduction

$2.94 in benefits ._ | o gD r'l St fethire.

for every $1.00 spent T — R
| i z{‘,w ¥

Benefit Summary for

P/Hsbumh s Street Trees

Benefits Total ($)
Energy 51,205,133
we R 2 == Management
Air Quality 952,035 ue - okt v 7
Stormwater 334,601

Aesthetic/Other  572.882

-3 Total Benefits 2.400.975

- The only infrastructure
t*/g ASBUOUDUCnuhnchmm . .
§ that increases in value

Think ahom ..
over time.




What are your urban forestry challenges
and opportunities?

Executive Summary

Foneer Valley Plonnmg Commvssion

PioneerValley
Climate Action and
Clean Energy Plan

Moving toward @ carbon newtral future.

March /2014




i-Tree Tool Selection Framework

. Database
My objectives?

Eco: Tree/Population

Ecosystem Services
Calculator

UTILITIES

* Tool advantages,
limitations, and
options?

Design:

Local-scale
management

* Available resources?

* Technical capacity or
skillset?

CORE PROGRAMS

e Timeline?

Landscape:
Regional-scale
management

 Audience?

e What does success

] ?
look like for me: i-Tree Tools & Model Relationships

SCIENCE



www.itreetool.org Resoures

Quantifies the benefits and values of

trees around the world.

s in tree and forest management

and advocacy.

Shows potential risks to tree and

forest health.

Is based on peer-reviewed, USDA

Forest Service Research.

Rapidly assess human and forest population information; threats to help

prioritize areas for tree plnn.’f‘tg{; protection.

] Y

Easily estimate tree canopy and benefits using aerial photographs.

lree D

Parcel level analysis of current and furure tree benefits.

. [
Iree |
Flagship tool that quantifies the structure of, threats to, and benefits and

values provided by forest populations globally.

See all the i-Tree tools, past and present, listed here.




Keys to Using i-Tree Effectively

e Understand tool advantages, limitations, and options
available.

* Define your objectives.

e Cani-Tree can be used to help you achieve desired
outcomes?

* Evaluate your available resources (time, equipment,
money, technical capacity, potential collaborators) to
plan, manage and complete a project.

* Consider pilot projects that can be used to learn, show
potential, and justify scaling up projects.

* Connect data and results to things that matter to
people.




MyTree

i-Iree.



i-Tree on the go...

@® treetools.org

s ... ' for individual or multiple trees!

i-Troe

MyTree Benefits ﬂ

Serving size: 1 ElIm, Chinese (Ulmus
parvifolia)

Carbon Dioxide(CO3) $108.34

CO; absorbed each year 2778.08lbs

Storm Water $28.63

Rainfall intercepted each year 4618 gal.

Air Pollution removed each year $1.82

MyTree Benefits

Serving size: 1 Eim, Chinese (Uimus.
parvifolia)

Ozone 12.00 oz

Carbon Dioxide(CO2)

Nitrogen dioxide 0.48 oz
Sulfur dioxide 0.16 07

Large particulate matter”™ 15.20 oz

Energy Usage each year $10.10

Electricity savings(A/C) 96.54 kWh

Fuel savings{NG,0i1) -13.99 therms

Avoided Emissions

Carbon dioxide 1223.201bs

Nitrogen dioxide 0.00 oz




I-Tree Eco

i-Iree.



Project Configuration Data

[Project: Adrian] [Serie;drian_ZOIZ] [Year: 2012] -Eee?co v6.0.3

(= | E et

Project Land Ground Dieback
Definition = Use Cover

Define Data Fields

N

View Reports Forecast Support
Load from File 2= @ ‘—J/
B3 via Gooagle Maps
(&3 o Project & c Editing
2 User Defined Strata Area Mode: Off
Define Plot Export

Help

Project Configuration > Project
Definition > Project Settings

The Project Settings tab seen in the
action panel to the right is where you
identify many of your most important
project settings.

Steps:

1. Enter a name for your project in
the box provided. Your project
name gives your i-Tree Eco
project a unique identity. This is
also the name that will be used
when referring to your study
area in your model results
(available on the Reports tab of
the ribbon).

2. Enter a series name for your
project in the box provided.
Again, your series name helps to
give your project a unique
identity. It can be used to
identify the exact nature of the
project - for example,
“ParkTrees” or “City" - to
distinguish it from other Eco
projects done at the same time in
the same place, if necessary.
This series name can be used in
the future to reference the data
for this project.

3. Enter a series year in the box
provided. It is recommended that
you enter the year of your data
collection for this variable.

-~

m

Project Configuration > Project Definition

Enter project overview information and click OK to save it or Cancel to quit this
process.
Project Settings ‘ Location | Data Collection Options

What name would you like to give your new project?
Project Name: |Adrian

What name would you like to give your series?
Series Name: Adrian_2012

Please specify the series year for your project:
Series Year: 2012

Please specify the following inventory information:

Inventory Type: Plot Sample

iI-Tree Eco v6

Flagship tool with best
estimates for Composition and
Benefits.

» User interface & Help text
* Reporting

* Tree inventory import

* Mobile data collector

Help text

Plot Sampling & Complete
Inventories



[Project: Adrian] [Series: Adrian_2012] [Year: 2012] - i-Tree Eco v6.0.3 E@]ﬂ
Project Configura Data View Reports Forecast Support

— 0pg0 =

= 8 B H@sMEEEXS @ |
Paper | Submit Retrieve Plots Trees Shrubs Check | CSV KML | Benefit Annual Editing

Form ' to Mobile from Mobile Data Prices Costs | Mode: Off

Data Collection ‘ Inventory Data ‘ Export ‘ Inventory Value’
Help il
~ | Data > Inventory Data > Trees

Data > Inventory Data > Trees Tl

The Trees table seen in the action Plot ID Survey Date Status Distance (ft) Direction Species 3

panel to the right displays the tree

data that you collected in the field 1 1 4/24/2012 Planted 0.00 140 | Red maple (Acer rubrum)

(s.e e Notes below). This is where you = 2 1 4/18/2012 Ingrowth 21.20 208 | Boxelder (Acer negundo)

will enter your tree data manually or

edit your previously added or 2 2 4/18/2012 Ingrowth 31.00 206 | Boxelder (Acer negundo)

imparied date. Wiile working in this 3 1 4/25/2012 Planted 30.70 178 | Freeman maple (Acer x freemanii)

table, you may use the tools in the

Actions group to help manually enter 4 1 4/23/2012 Ingrowth 21.30 32 | Tree of heaven (Ailanthus altissima’

new data or edit data that has ] |4 2 4/23/2012 Planted 2240 224 | Norway maple (Acer platanoides)

already been added.
D4 3 4/23/2012 Planted 37.20 298  Northem white cedar (Thuja occide

Steps to Manually Add/Edit Data: 7 1 4/19/2012 Ingrowth 35.00 14 | Siberian elm (Uimus pumila)

1. Click in the box where you would —
like to enter data and begin 7 2 4/19/2012 Planted 30.00 80 | Honeylocust (Gleditsia triacanthos)
typing. 7 3 4/19/2012 Ingrowth 26.80 130 | Black walnut (Juglans nigra)

2. Usethe Tab key on your -
keyboard or the left and right 7 4 4/159/2012 Ingrowth 22.30 258 | Blue spruce (Picea pungens)
arrows to move from side to side 8 1 4/24/2012 Ingrowth 28.20 20 | Siberian elm (Uimus pumila)
within a record. 7y -

3. Usethe up and down arrows on 8 2 /24/2012 Ingrowth 25.80 30 | Black walnut (Juglans nigra)
the keyboard to move from top to 8 3 4/24/2012 Ingrowth 28.10 43 | Norway maple (Acer platanoides)
bottom between records. ) -

4. For boxes that contain drop- 1" 1 4/27/2012 Ingrowth 11.80 338 | Shellbark hickory (Carya laciniosa)
down lists, you can choose your 1 2 4/27/2012 Ingrowth 15.20 338 | Black chemy (Prunus serotina)
thaia from the I.'St or beg|rj typing 1 3 4/27/2012 Ingrowth 3460 352 | American elm (Ulmus americana)
and the matching label will be
automatically filled in. 1" 4 4/27/2012 Ingrowth 10.00 0 | American elm (Ulmus americana)

5. Thetable can be sorted by 1 5 4/27/2012 Ingrowth 17.70 10| Black cheny (Prunus serotina)
column in ascending or
descending order. To sort, click 1 6 4/27/2012 Ingrowth 35.20 20 | Silver maple (Acer saccharinum)
on the desired column header. 1 7 4/27/2012 Ingrowth 15.10 20 | Buttemut (Juglans cinerea)

6. For boxes where dates are
entered, a calendar pop-up will 1 8 4/27/2012 Ingrowth 28.70 30 | American elm (Ulmus americana)

appear if you click on the

t-hand

»

i-Tree Eco v6

Flagship tool with best
estimates for Composition
and Benefits.

* User interface & Help Text
* Reporting

* Tree inventory import

* Mobile data collector

Help text

Plot Sampling & Complete
Inventories.



Adrian)] [Series: Adrian_2012] [Vear: 2012] - i-Tree Eco v6.0.3 B T) i-Tree Eco VG

S} oL ) |

»

ution and

= ‘| Flagship tool with best
eather ~ ~ | Names~ . o,
o estimates for Composition
nmary > By Species and BEHEfItS.

Notes

Total Estizaates for Trees in Adrian by Specien

N wmmer o0 Do *_-'“_.-L‘.flw.lz’.:‘: = A Laet o B
= —i:—‘ﬁiiz"‘ L e ‘OooB/(ejan
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e ) o s o et s 1 |
el e el owal e THi Y ST 3 M
B e * User interface & Help text
=) e s ) e ) ) O ,
S S S SSSS SR — .
EE_ﬁ————‘\"\ * Reporting
S (O
e N & * Tree inventory import
*ﬁ%-%c()
—t
—T) -1 :
= * Mobile data collector
— e —

* Basic mapping

\:: Shagbark hickory
. Eastern redbud

Plot Sampling & Complete
Inventories.

z Northern hackberry
- Alaska cedar
- Flowering dogwood




i-Tree Eco - Data Import Wizard [ o)

Select an inventory column below and then define how to import it into Eco. Repeat for EACH

at that time. Pl
your data, the
may not reflect
made. To ensu
data to the se
again.

column BEFORE clicking Next

b= D8H Trunks

Cond

| Caaly

WeakFork “ |

Total records procesesd. 520
Total records skipped: 7
Total records to mpert: 483

Processed Dala to Import

Review the results of your processed data.

Species

Acer ubrum

Please review your data after chcking Finish. Addtional modfications may be required to meet your project specrfic requIrements.

Cick Finigh Lo complets the import process or cick Back Lo revies your sstings end reprocess your dats.

=

[ <Beck || Ensh | [ Conce |

I Prunus seroting

Pruruz saroting

[ <geck [ Net> | [ Concel |

i-Tree Eco v6

Flagship tool with best
estimates for Composition
and Benefits.

e User interface & Help text
* Reporting

* Tree inventory import

* Mobile data collector

* Basic mapping

Plot Sampling & Complete
Inventories.



Help

Land Use

Data > Data (
Mobile

Status

emm (o)
iTree Eco of Direction (%)

recording thq
the field. Onq
record your
data collectg
mobile data
enabled mobl
smartphone
your collecte
from the web
tab of ribbo
functionali
have to dow
web-based i
form.

Distance (ft)

Street Tree ?

Comment

The purpose
function seer
the right is tc
configuration}
will be able tf
mobile devicé
mobile data
below).

*IMPORTANT
Before you ca
mobile data co!
device, you must
configuration here (see™
If you do not submit your project
configuration, you will not be able to
access the mobile data collector from
your mobile device.

from tmp = s builging co

Residen| Plot Info

1-Ingre Land Uses

Ground Covers

Reference Objects

Trees

Shrubs

Mark Plot as Completed

[C]|3259

[C]|3260 11/1/2010

o tive_Use] erar: 2010] - i-Tree Eco v6.0.3

iI-Tree Eco v6

Crown Condition

Height (ft)

Crown Top Height (ft)

Crown Base Heght (ft)

Crown NS Width (ft)

Crown EW Width (ft)

Crown Percent Missing o3

Crown Light Exposure | 4

Percent Impervious

Percent Shrub

Plot1-GPS Loc...

Type in coordinates, use device GPS, or tap a location
on the map below.

Dead Tree?

85% - 90% v Latitude

41.908656011

Longitude -84.0385827151

Device GPS (allow location access on device):

cessing

U
dress

Timestamp
- access '
V) Ifee Accuracy (ft)
v Project . . .
Tap map for coordinates (requires data connection):
0 o
63 v ne
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Reports > Map > Composition and Structure of Individual Plots e ] X
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i-Tree Eco v6

Flagship tool with best
estimates for Composition

and Benefits.

e User interface & Help text

* Reporting
* Tree inventory import

e Mobile data collector

* Basic mapping

Plot Sampling & Complete
Inventories

© OpenStreetMap contributors.




I-Tree County




I-Tree County

A collaborative initiative with

Sa AMERICAN FORESTS

Assess the following...

Total carbon stored (tons and dollar value)

Annual carbon sequestration (tons and dollar value)
Air pollution removal per year (pounds

of NO,, SO,, O; and PMy, or PM, ¢)

Estimate of pollution removal effect relative to
automobile emission (i.e., reduction in number of
vehicles per year that equals pollution removal)
Pollution removal value per year (dollar values
associated with improved human health)

Avoided health incidences due to improved air quality
per year (numerous metrics including avoided mortality)
Annual transpiration (millions of gallons)

Annual interception (millions of gallons)

Annual avoided runoff (millions of gallons, dollar value)



i-Tree County

AMERICAN FORESTS

i-Tree.

County

ﬂ i-Tree COUnty._., ) Home  Projects Menu~  ITree
i-Tree .
| . ey

Q

E3 My County Benefits | & My Project Benemts  +

o)

Lok

. _Mississauga
Kitehene: {/ )
Szraefoed o i Hamfton \\
/" Beaniford<"~ —e=mC |
Wioodsack St. Cachark
Londoh Port Colbornes

5% Thamas

Cuyahoga County, Ohio
Total Removal (Ib/year)
Annual Air Pollution Removal
9,110.574.5 o/

Valued at $50,123 028

(2}

Disable popup for this selection?

B pavey® Owcpommsen il [SR

Casey Tred

Feedback «
County Benefits
Carbon and Carbon Dioxide Benefits +
Annual Ar Pollution Removal ad

Poor air qualtty is 3 common problem in many
urban areas Il can lead Lo healh problems
lsndscape damage. degraded ecosysiems, and
reduced visibdity

@ Total Removal (kiyear) e M

[:_

Transparency 0 %
@ £ Removal (uyear) e Wl
Q@ NQ:z Removal (hiyear) e M
@ £z Removal (iyzan e M
@ QuRemoval (biyean e M
D EBM.2sRemoval (kiyear) e M
@ EMur Removal (pyear) e M
Equivalent Automobde Reduction +
Avoided Health Incidence +
Annugl Hydrological Benefits +
Base Maps -
| Open Strest Map v

Use these 100Is 10 work with the map:

3 Navigate 4 Select




i -Tre e co u nty ﬁ I-Tree Cou nty 5 Home = Projects  Menu~  i-Tree Feedback v

ruunu,lu.yu .
County Benefits
Nmrp.:rb.c‘. :

\

Carbon and Carbon Dioxide Benefits +

Collaborative project with pr
. ] § t M.5§|§;3093 Annual Air Pollution Removal -
American Forests st i

/' Brantfard ™ =
Woodstock St Cathar

+

Equivalent Automobile Reduction

o+

Londor Port Coltomile. = Avolged Health Incidence

51. Thomas

Annual Hydrological Benefils

Q) Transpiration (MG

AMERICAN FORESTS

@ Avoided Runoff (MGlyear)

5

®

&

8
00
-

Cuyahoga County, Ohio B
Avolded Runoff (MGlyear)
‘ , . Transp: 0 3
Annual Hydrological Benefits sk >
1,756 1 MG
Valued at $15.692,313 Base Maps —
Disable popup for thes selection? Open Street Map v

County

Use these tools to work with the map:

3 Navigate o Select

W Reset All

Arbor Day Foundsatic 1.7 ! :
u WEY‘% @ Arbor Day on ISA ? ﬁAMERlCANFORESTs




i-Tree County

Collaborative project with
American Forests

AMERICAN FORESTS

i-Tree.

County

Tree Benefits Report - i-Tree County,, .

i-Iree
Generated: 11/14/2018 Total Area: 797,175.5 acres
Location: Cuyahoga County, Ohio Canopy Area: 109,000.8 acres, 13.7% of total area
ONTAR O QUEBEC ; ‘; Kngnono//
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- n ~ e
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| i 5 BEORNGIR incinngti
G | & DI IANA > G | i WSSN_M(M
O ; g c A IAN Map dacs 22013 Google, INEGI  Terms of Uise o g e Mag dans 2019 Geogle ‘Yer—a of Une

Cuyahoga county's trees provide the following benefits:

Annual Air Pollution Removal Benefits

9.110,574 5 oy Total Air Poliution Removal
50,123,028 Sor

135,154 9 11404 CQ Removal

$0.115 Sl

1.239,925.2 oo NQ, Removal

368,993 S{vr

(2

Annual Avolded Health Incidence Due To Improved Air Quality

B 19 Emergency Room Visits
1239 Hospital Admissions

5392 06 Acute Respiratory Symptoms
1658 98 Asthma Exacerbation

5.62 Mortality

936 .81 School Loss Days




I-Tree Planting




ﬂ i-Tree Planting ..,  Home Project~  Menu~  i-Tree

i-Tree.

Welcome to the i-Tree Planting Calculator! ..,

The i-Tree Planting Calculator is designed to help you estimate the long-term environmental benefits from a tree

planting project. The focus is on greenhouse gases, but many co-benefits are included.

This is a newly updated version of i-Tree Planting. Please clear your web browser's cache for this site before using.

Users enter the following information:

The following information is calculated (in units and associated dollar values) for the project life time:

Tree species

Size of trees at planting

Information on the distance and direction to the nearest building (optional)
Information about the tree’s growing conditions

Estimated mortality (optional)

The number of trees with each configuration

Project lifetime (number of years)

Specific greenhouse gas values (optional)

Greenhouse Gas (GHG) sequestered and avoided (owing to reductions in energy use)
Energy conserved

Air pollutants captured and avoided

Stormwater filtered

Tree total biomass

QN A DEPAK
A m

#© e Uy

";:”,"' L Tecy,

california |
Eiurbanforests .

Urban Ecos

Feedback v

i-Iree

Planting

O Get Started

Use of this tool indicates
acceptance of the EULA.



A collaborative initiative with

ORNIA DEPARTy s
AMFOCY & FIRE PROTNT o
fsoil Loy

% |—Tree PIant'ng o Home Project » Menu ~ i-Tree Feedback v

i-Iree
Location Parameters Trees Report
Location

Select a location at, or near, the project site.

State/Province

<>

Massachusetts

County/Division

<>

Hampden

City
Springfield

<>

WARNING: If you already have tree groups entered, they will be retained, but changing the location will change the Report results.

Each of the three location selections needs to be completed in order:

e State
e County
. City

At this time, the i-Tree Planting Calculator is only for users located within the United States. Please contact support@itreetools.org for more information
about funding needed for your area.

Arbor Day Foundation” i’m;o

DAVEY‘%O




A collaborative initiative with % i-[ree Planting 0 Home  Projectv  Menuv  i-Tree Feedback ~

i-Iree

Location Parameters Trees Report

ORNIA DEPARTy s
AMFOCY & FIRE PROTNT o
fsoil Loy

Project Parameters

Configure the local parameters for the project.

Electricity Emissions Factor
505.21

This field is required.
Units
pounds GQ» equivalent/MWh ® kilograms GO» equivalent/MWh

vvvvvvvv At ottt S

Fuel Emissions Factor
68.71

This field is required.
Units

Years for the Project (1 thru 99)

40

Tree Mortality over Project Lifetime, as an estimated percentage (Optional, 0 thru 100)

10




A collaborative initiative with

DEPART,

FORNIA MEN,
AUF Ry & FIRE PROT: T o,
:o\“m TE("of,

O i-Tree Planting ,,;  Home  Project~

i-Iree

Location Parameters Trees Report

Tree Planting Configurations
Enter the tree groups for the project.
Units

@® English (feet & inches)  © Metric (meters & cm)

Nomenclature

® Common Name © Scientific Name

Tree Group Information

DBH in
Species inches

V Apple {(0-19 3)!(North (09) D)

Apple, Paradise

Menu v i-Tree

Building Information

Distance
to
Nearest Tree is of Climate
in feet Building Vintage Controls Condition

Feedback v

Tree Details

Exposure to Nu|
Sunlight

(Built after 1980 %)

(Heat& A/C %) i ( Excellent ¥ i (FulSun %)

Ash

Ash, American mountain
Ash, Black

Ash, Carolina

Ash, European mountain
Ash, Green

Ash, Summit

Ash, White

Aspen, Bigtooth
Aspen, Quaking

Baldcypress
Basswood
Basswood, American
Bayberry, Southern
Beech

Use of this tool indicates acceptance of the EULA.




A collaborative initiative with

EPART,
FORNIA D! MEN,
AUF Ry & FIRE PROT: T o,
:‘.’Rgs'“ TEc,,O:‘

% |—Tree PIant'ng O Home Project v Menu v~ i-Tree
i-Tree o

Location Parameters Trees Report

Planting Report

NOTE: Printing is recommended as the "landscape" orientation or at a reduced scale.

Project Report - i-Tree Planting Calculator,,,;

Location: Springfield, Massachusetts 01109

Electricity Emissions Factor: 505.21 kilograms CO2 equivalent/MWh
Fuel Emissions Factor: 68.71 kilograms CO2 equivalent/MMBtu
Lifetime: 40 years

Tree Mortality: 10%

All amounts in the tables are for the full lifetime of the project.

Units
@® English (pounds & tons; kWh & MMBtu; gallons)  © Metric (kilograms & metric tons; KWh & MMBtu; cubic meters)

Copy Export CO, = Energy Eco Air Pollution

Location CO, Benefits
1 €O, Co,
Group Avoided Avoided
Identifier = Tree Group Characteristics (pounds) $)
1 e (1.0) Apple (Malus species) at 1.0 inch DBH. 2,649.2 $61.61
o Planted 0-19 feet and north (0°) of buildings that were built post-1980 with heat
and A/C.

o Trees are in excellent condition and planted in full sun.

Search:
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I-Tree Canopy

Quick, statistical
estimate of Canopy
cover and associated
benefits.

* Create custom cover
classes

 Random point locations

* Does not automatically
assign cover class at point

Enhanced Ul coming soon!
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$174.40 +47.52

co Carbon Monoxide removed annually

NO2 Nitrogen Dioxide removed annually $156.26 +42.58
03 Ozone removed annually $9,24984 +2520.35
PM2.5 Particulate Matter less than 2.5 microns removed annually $17,942.75 +4,888.94
S02 Sulfur Dioxide removed annually $6.22 +1.69
P10 Particulate Matter greater than 2.5 microns and less than 10 microns $6.763.14  +1.842.78

removed annually
CO2seq Carbon Dioxide sequestered annually in trees $81,603.57 +22.234.90

Carbon Dioxide stored in trees (Note: this benefit is not an annual
CO2stor rate)

656.72 Ib
1.511.65 Ib
948 T
848.77 Ib
133.89 Ib

248T
231464T

$1,321,118.93 £359,971.39 3747284 T 1




preview

I-Tree Canopy
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C @ localhost

ﬁl i-Tree Canopy e F v M - .

-Tree

Configuration step 1 of 3: Use the map and tools provided to define the area you want to survey. The easiest option

areas r

ght on the map. or load in one or more shapefiles
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Select a Shapefile
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to select a pre-existing boundary, but you can draw your own
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preview

I-Tree Canopy

€ C @ localhost * DEE OO0
ﬂ Iree Canopy ' v - m~ .

Configuration step 1 of 3: Use the map and tools provided to define the area you want to survey. The easiest option is to select a pre-existing boundary, but you can draw your own
are

as nght on the map. or load in one or more shapefiles

Map data £2010 imagery £2019 NASA TerraMatrics | Terms of Use
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preview

I-Tree Canopy

@¥ i-Tree Canopy x 4+ - () X
< C @ localhost:8001/map# * DE@E OO0

ﬂ i-Tree Canopy ¢, sme Project Menu™ Tree Feedback ¥

+Iree

Configuration step 1 of 3: Use the map and tools provided to define the area you want to survey. The easiest option is to select a pre-existing boundary, but you can draw your own
areas right on the map, or load in one or more shapefiles.

luct curi >N {aht intn curvey mode with a
JUST CUnQuUss Ove ngnt inlo survey moge wilh an
n
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Launch Our Example Project

Ready to survey your own
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R O US 115" Congressional Districts
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ESRI Shapefile

Draw or Add Areas
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Map data ®2019 Imagery 22019 NASA TerraMetrics | Terms of Use




preview

I-Tree Canopy

@ i-Tree Canopy x +

<« C @ localhostB001/survey * @ @ 00
g i-Tree Canopy sy Home Project Menu~ i-Tree Feedback v
i-Tree

Conduct your survey: With each point you add, the map will shift to a new, random location where you assess the land cover at the yellow crosshairs in the center of the map. The more
points you survey, the lower your standard error, and the more precise your sampling will be. More points provide a better estimation of Land Cover across your study area.

ID Cover Class Latitude Longitude
Impervious Other 41.74094 -72.65320
Impervious Road 41.74315 -72.66277
Tree/Shrub 41.76941 -72.68937
Grass/Herbaceous 41.78738 -72.69409
Tree/Shrub 41.73479 -72.67216
Impervious Other 41.78946 -72.66989
Tree/Shrub 41.79791 -72.71115
Tree/Shrub 41.74369 -72.66156
Grass/Herbaceous 41.80402 -72.71483

10 Grass/Herbaceous 41.79908 -72.65136

+ 2 W M Page1ofS0 M m




i-Tree Canopy preview
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I-Tree Wood Marketplace
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Boundaries

. Canopy Forest Admini )
. 3 ) 1 ministrative
®N i-Tree Landsg Main g Land Risk i
— (@) us Census Block Groups

i-Tree Landscape

Gateway to tree benefits — available to anyone and it Q@ s Census Places
everyone in the US. Camale 2030 (RCP 45) (X US County Subdivisions

Climate 2040 (RCP 4.5) (@ uscounties

Cimate 2050 (RCP 4.5) () us 115" Congressional Districts
ima 5)

* Uses existing boundaries. QD us states

Climate 2060 (RCP 4.5)

* Canopy, Land, and Impervious Cover across i 2070 PP 41 Forest (US Forest Service)
the US. ' (@ National Forests
« UTC-send us yours! G e (D Ranger Disticts
* High Resolution Urban Tree Canopy Assessments Climaie 2090 (RCP 4.5) CFLR Boundaries
e 250+ map |ayers o Climate 2100 (RCP 4.5)
e 7 base maps Oimetéqals . ‘
Climate 2020 (RCP 8.5)
* 10 boundaries, plus 26 federal types
* 7 canopy and land Climate 2030 (RCF 8.5) 1 US Federal Lands
* 6 forest risk, plus 47 pests Climate 2040 (RCP 85) Native American Reservation
e 17 health risk . Climate 2050 (RCP 8.5) Bureau of Land Management

* 144 future climate Find Locations
* Up to 18 new ones coming with v5.0

Climate 2060 (RCP 8.5)
Bureau of Reclamation

Climate 2070 (ACP 8.5)

* 1,000's of data attributes and tree benefits e 2080 P A
organized for easy exploration. Deparment of Energy
. . oy . e foloutg descripionil Climate 2090 (ACP 8.5) +
o Pla ntlng prlOrltlzathn tOOI more detaifs and a thorough Forest Service

Climaie 2100 (RCP 8.5) +

'
Let S Get Star Note: Predicted temperature and precipitation based Fish and Wildlife Service
on CCSM4.0 from Nafional Center for Aimospheric
Each i-Tree Landscape ploq Research.

National Park Service

shown below the map. (To

Map defails are localed in the references.




i-Tree Landscape

Gateway to tree benefits — available to
anyone and everyone in the US.

A good place to get people started
in i-Tree.

A quick tour of...

* Location Data
* Making a selection
* Land Cover classifications
* and tree canopy
* Thematic mapping

@ Explore Location Data

&« - C o
ﬂ i-Tree Landscape ...
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Choose a boundary area to analyze:

H

Find Locations Explore Location Data

Data Tools

Land Cover @

HiRes = 2011 | 2001

Area Land Cover HiRes Land Cover 2011

Canopy & Impervious Forest Details

Remove Dataset ¢ Type ¢ Name ¢ ID ¢ Swap Highlight

v Selection Total: O

Shaker H Peppy
% Enchwoo / US Census Block Group :] ®
i
I Use these tools to work with the map:
ights
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Bedford |
= Geo-Swap HC
See Tree Benefits Prioritize Tt
Map details are located in the references.
Unit Display
Metrc | English Table Chart m
Canopy Legend
Census [ Minimum: 0.6 “uture Climate

Maximum: 271.8

Lignter colors represent lower values, whia
darker colors represant higher values
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e
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i-Tree Landscape

Gateway to tree benefits — available to
anyone and everyone in the US.

A good place to get people started
in i-Tree.

A quick tour of...

 Tree Benefits

e Carbon (CO?), air pollution,
hydrology

* Planting Prioritization
* Weighted prioritizations
* Custom scenarios

* Maintenance vs new planting
* (vs highest priority; i.e. both)

&) Prioritize Tree Planting X } +

& - C ® | ®© & httpsi//landscape.itreetools.orgimaps/prioritize/

Find Locations Explore Lecation Data See |
Land Cover @
I
€ Back HiRes | 2011 = 2001

How To Prioritize Tree Planting

To map optimal areas to plant trees, create a "Prority Planting Index"

scenario from user-specified, weighted criteria (under Custom Scenarios)
or use one of the Commen Scenarics (abeve). Scenarios are based upon

the Land Cover dataset selected (above) - HiRes, 2011, 2001.

The three Common Scenarios are:

« Population: (default) an index weighted towards areas of relatively

high population density, low tree cover per capita, and high
available planting spaca.

« Minorities: an index weighted towards areas of relatively high
minonty population density, low tree cover per capita, and high
available planting space.

« Poverty: an index weighted towards areas of relatively high
proportion of population below the poverty ine, low tree cover per
capita, and high available planting spaca

To create a Custom Scenario:
1. Select from one or more criteria (the blue boxes under Custom

Scenarios) by using the + Add Criteria button and their drop-down.

» For each criteria, set an Importance (from 0 to 100). The
sum cf the all weights must equal 100.
» Optional: to distribute weights equally among the selected
criteria, click the Equalize button.
2. Click Update Map Display to see the results on map (above) and
legend (below).
3. Each Custom Scenario can be stored by clicking Store Scenario.
These saved scenarios can be included in your report when you
Generate Results

Current Prioritization Scenario Legend

The index is from 0 to 100, where 0 is a low priority and 100 is a high

B % IN € @ »

TTTTTTNUMT-WOOURO U TOW OENTSITy UBNRIOpRU 210U

*

Wooded to high density developed 2100
Wooded to low density developed 2100

Priority Planting Index Extras

Tree Stocking Level

Tree Cover per Capita

Population Below Poverty Line
Minority Population Density

Tree Canopy Benefits

Carbon Storage

Carbon Sequestration

CO: Equivalent Storage

CO: Equivalent Sequestration
CO Removal

NO:z Removal

Q3 Removal

PM;.5 Removal

High = Low

{ )
o

Trow Coverpor Capita 1 I

Imporiance (welght)

= Equalize

© Update Map Display

+ Add Crileria Slore Scenario

Stored Planting Prioritization Scenarios

Remember to update the map's display after restoring a custom

priority. prioritization scenario.
How? Remove Title Criteria Restore
—Each criteria is standardzed on a scale of 0 to 1, with 1 reoresenting the P v o r——

Population Density (3




i-Tree Landscape

Gateway to tree benefits — available to
anyone and everyone in the US.

A good place to get people started
in i-Tree.

A quick tour of...
* Reporting

* Title and description
 Example tables
 Example thematic map

Example prioritization map

landscape.itreetools.org
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¥ Report - i-Tree Landsca; X 4+

ETree Benefits

iCarbon and CO2 (High Resolution UT

C @ ®O0O& ntps//landscape itreetools.org/re

2porty

B % N €@

Carbon COz Equivalent COy Equivalent
Carbon Storage Sequestration Storage Sequestration
Short Ton '
q $ ¢ $ S$yr & Uy ¢ $ & ShortTong $yr ¢ tyr &
:Selection Total: 1.887.068  11.064.6 60259 3533 1.887.066 40,5700 60,259 1,205.5!
Prioritization
iPopulation (High Resolution UTC
- ST. Cl f-i
L SUPERI

wier Per

Edgewater

ark

B owey Oueomman & A P K

w

Mapdma®2015 TesmsofUse  Reportamap emor

Legend: v [N | 10NN >

NAASF

Use of this lool Indicales acceptance of the EULA

B

»

n x




www.unri.org

David Bloniarz

USDA Forest Service
David.Bloniarz@usda.gov
txt 413-537-3748
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